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About this document 

Scope and purpose 

This user guide provides an overview of the evaluation board EVAL-M1-IM241 including its main features, key 

data, pin assignments and mechanical dimensions.  

The EVAL-M1-IM241 is an evaluation board for motor drive applications, as part of the iMOTION™ modular 

application design kit. In combination with the control board equipped with the M1 20-pin interface connector 

such as EVAL-M1-101T, it features and demonstrates Infineon’s CIPOS™ Micro IPM technology and advanced 

motion control engine (MCE 2.0) technology for permanent magnet motors drive. 

The IM241-L6T2B CIPOS™ Micro IPM has 600 V of voltage and 6 A of current rating. It is optimized for small home 

appliances like pumps, fans and other low power motor drive applications. 

This evaluation board EVAL-M1-IM241 is developed to support customers during their first steps designing 

applications with CIPOS™ Micro IPM IM241-L6T2B and running any permanent magnet motor via sensorless 

sinusoidal control. 

Intended audience 

This user guide is intended for all technical specialists who know motor control, low-power electronics 

converters. The board is intended to be used under laboratory conditions. 

Evaluation Board 

This board will be used during design in, for evaluation and measurement of characteristics, and proof of data 

sheet specifications.  

Note: PCB and auxiliary circuits are not optimized for final customer design.
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Important notice 

“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board 

(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration, 

reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).  

Environmental conditions have been considered in the design of the Evaluation Boards and Reference 

Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards 

has been tested by Infineon Technologies only as described in this document. The design is not qualified 

in terms of safety requirements, manufacturing and operation over the entire operating temperature 

range or lifetime. 

The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional 

testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the 

same procedures as regular products regarding returned material analysis (RMA), process change 

notification (PCN) and product discontinuation (PD). 

Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for 

evaluation and testing purposes. In particular, they shall not be used for reliability testing or production. 

The Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards 

(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other 

requirements of the country in which they are operated by the customer. The customer shall ensure that 

all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant 

requirements and standards of the country in which they are operated. 

The Evaluation Boards and Reference Boards as well as the information provided in this document are 

addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and 

managed according to the terms and conditions set forth in this document and in other related 

documentation supplied with the respective Evaluation Board or Reference Board.  

It is the responsibility of the customer’s technical departments to evaluate the suitability of the 

Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness 

and correctness of the information provided in this document with respect to such application. 

The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not 

cause any harm to persons or third party property.  

The Evaluation Boards and Reference Boards and any information in this document is provided "as is" 

and Infineon Technologies disclaims any warranties, express or implied, including but not limited to 

warranties of non-infringement of third party rights and implied warranties of fitness for any purpose, or 

for merchantability.  

Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation 

Boards and Reference Boards and/or from any information provided in this document. The customer is 

obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or 

damages arising out of or resulting from any use thereof. 

Infineon Technologies reserves the right to modify this document and/or any information provided 

herein at any time without further notice. 
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Safety precautions

Note: Please note the following warnings regarding the hazards associated with development systems. 

Table 1 Safety precautions 

Warning: The DC link potential of this board is up to 400 VDC. When measuring voltage 

waveforms by oscilloscope, high voltage differential probes must be used. Failure to do 

so may result in personal injury or death.

Warning: The evaluation or reference board contains DC bus capacitors which take 

time to discharge after removal of the main supply. Before working on the drive 

system, wait five minutes for capacitors to discharge to safe voltage levels. Failure to 

do so may result in personal injury or death. Darkened display LEDs are not an 

indication that capacitors have discharged to safe voltage levels. 

Warning: The evaluation or reference board is connected to the grid input during 

testing. Hence, high-voltage differential probes must be used when measuring voltage 

waveforms by oscilloscope. Failure to do so may result in personal injury or death. 

Darkened display LEDs are not an indication that capacitors have discharged to safe 

voltage levels. 

Warning: Remove or disconnect power from the drive before you disconnect or 

reconnect wires, or perform maintenance work. Wait five minutes after removing 

power to discharge the bus capacitors. Do not attempt to service the drive until the bus 

capacitors have discharged to zero. Failure to do so may result in personal injury or 

death. 

Caution: The heat sink and device surfaces of the evaluation or reference board may 

become hot during testing. Hence, necessary precautions are required while handling 

the board. Failure to comply may cause injury. 

Caution: Only personnel familiar with the drive, power electronics and associated 

machinery should plan, install, commission and subsequently service the system. 

Failure to comply may result in personal injury and/or equipment damage. 

Caution: The evaluation or reference board contains parts and assemblies sensitive to 

electrostatic discharge (ESD). Electrostatic control precautions are required when 

installing, testing, servicing or repairing the assembly. Component damage may result 

if ESD control procedures are not followed. If you are not familiar with electrostatic 

control procedures, refer to the applicable ESD protection handbooks and guidelines. 

Caution: A drive that is incorrectly applied or installed can lead to component damage 

or reduction in product lifetime. Wiring or application errors such as undersizing the 

motor, supplying an incorrect or inadequate AC supply, or excessive ambient 

temperatures may result in system malfunction. 

Caution: The evaluation or reference board is shipped with packing materials that 

need to be removed prior to installation. Failure to remove all packing materials that 

are unnecessary for system installation may result in overheating or abnormal 

operating conditions. 
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The board at a glance 

1 The board at a glance

The EVAL-M1-IM241 evaluation power board is a part of the iMOTION™ modular application design kit for motor 

drives (iMOTION™ MADK). The MADK platform is intended for use with various power stages and different 

control boards. The EVAL-M1-IM241 can easily be interfaced through the 20-pin iMOTION™ MADK M1 connector 

such as EVAL-M1-101T, and is intended for single-motor control only. 

The EVAL-M1-IM241 evaluation board is available through regular Infineon distribution partners as well as on 

Infineon's website. The features of this board are described in the main features chapter of this document (UG-

2021-01), whereas the remaining paragraphs provide information to enable the customers to copy, modify and 

qualify the design for production according to their own specific requirements.  

Environmental conditions were considered in the design of the EVAL-M1-IM241, but the board is not qualified in 

terms of safety requirements or manufacturing and operation over the entire operating temperature range or 

lifetime. The boards provided by Infineon are subject to functional testing only. 

The evaluation boards are not subject to the same procedures as regular products regarding returned material 

analysis (RMA), process change notification (PCN) and product discontinuation (PD). Evaluation boards are 

intended to be used under laboratory conditions by technical specialists only. 

1.1 Delivery content

The EVAL-M1-IM241 evaluation board is designed to provide an easy-to-use power stage based on the 

Infineon's CIPOS™ Micro intelligent power module (IM241-L6T2B IPM).  

The delivery includes the finished board as shown in Figure 1 and Figure 2. It provides a single-phase AC 

connector, an EMI filter, input rectifier, DC bus capacitors and 3-phase output for connecting the motor.  

It also contains CoolSETTM based auxiliary power supply to provide 15 V & 3.3 V, emitter shunts for current 

sensing and overcurrent protection, and a voltage divider for DC-link voltage measurement. The board shown 

here can be operated directly with the required power supply without the need for additional components. 

1.2 Block diagram

The block diagram of the EVAL-M1-IM241 is depicted in Figure 1.  

Figure 1 Block diagram of the EVAL-M1-IM241 
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Figure 2 points out the functional groups on the top side of the EVAL-M1-IM241 design: 

Figure 2 Functional groups of the EVAL-M1-IM241 reference design 

1.3 Main features 

The EVAL-M1-IM241 is an evaluation board for motor drive applications. Combined in a kit with one of the 

available MADK control board options, it demonstrates Infineon’s motion control IC and IPM technology for 

motor drives. 

The evaluation board characteristics include: 

 Input voltage 110~230 VAC

 Maximum 2.5 A input current at 110VAC

 Maximum 250 W motor power output at 220VAC

 On board EMI filter and pass EMI standards EN55032 

 Auxiliary power supply with 15 V, 3.3 V 

 Overcurrent hardware protection & over temperature protection 

 Sensing of DC-link voltage 

 Thermistor output 

 PCB is 100 mm × 100 mm, two layers with 2 oz. copper 

 RoHS compliant 

1.4 Board parameters and technical data 

Table 2 depicts the important specifications of the evaluation board EVAL-M1-IM241. 

1. 220 VAC & PE input connector

2. In-rush limited and fuse 

3. EMI filter 

4. Auxiliary power supply  

5. iMOTIONTM MADK M1 

connector (20-pin) 

6. CIPOSTM Micro IPM-IM241 

7. UVW motor phase connector 

8. Heatsink 

1
2

3

4

5

6

7 8
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Table 2 Parameter 

Parameter Symbol Conditions Value Unit

Input

Input voltage VAC Lower AC input, less motor 

power output 

110 ~ 230 Vrms

Input current  IAC(max1) Input 220 VAC , fPWM=6 kHz, 

Ta=25°C, TC=100°C,Pout=250 

W 

1.7 Arms

IAC(max2) Input 110 VAC , fPWM=6 kHz, 

Ta=25°C, TC=100°C,Pout=180 

W 

2.5 Arms

Output

Power(3 phase) Pout(max) Input 220 VAC , fPWM=6 kHz, 

Ta=25°C, TC=100°C 

250 W 

Current per leg Iout(max) Input 220 VAC , fPWM=6 kHz, 

Ta=25°C, TC=100°C 

1.4 Arms

DC bus

Maximum DC 

bus voltage 

VDC(max) AC input 230 Vrms 325 V 

Minimum DC 

bus voltage 

VDC(min) AC input 110 Vrms 156 V 

Current feedback

Shunt 

Resistance 

RS3,RS4,RS5 leg shunt 100 mΩ 

Protections

Over current 

protection 

IOCP Configured by either 

changing shunt resistors 

RS3, RS4, RS5 or adapting 

comparator threshold 

changing resistor R35 

4 1 Apeak

Auxiliary power supply 

VCC voltage 

output 

VCC Used for IPM power supply 15 ± 5% V 

VCC current 

output 

IVCC Used for IPM power supply 100 mA 

3.3 V voltage 

output

V3.3 V Used for IMC controller and 

protection circuits 

3.3 ± 1% V 

3.3 V current 

output 

I3.3V Used for IMC controller and 

protection circuits 

200 mA 

PCB characteristics

Dimension Length × width 100 × 100 mm

1     For iMOTION™ IC IMCxxx, there are three types of Gatekill input source options in MCEWizard setup: Gatekill-pin, Comparator and 

Both.  If you select “comparator” mode, the external Gatekill signal will be not used, and the signal I_Shunt will be compared by the 

internal comparator with the “Device overcurrent trigger level setting” value set in MCEWizard.  
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Parameter Symbol Conditions Value Unit

Material FR4, 1.6 mm thickness, 2 oz.  

PCB 

System environment

Ambient 

temperature

Ta 25 °C 
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2 System and functional description 

2.1 Getting started with EVAL-M1-IM241 

In order to run the motor system, a combination of the iMOTION™ MADK power board (EVAL-M1-IM241) and the 

matching MADK control board (EVAL-M1-101T or other control board) are required. This chapter provides more 

details on setting up the system and getting started with the iMOTION™ MADK development platform. 

The EVAL-M1-IM241 evaluation boards are tested with EVAL-M1-101T controller boards, which shipped with 

embedded firmware and default parameters.  

The following steps have to be performed in order to achieve a usable motor controller IC from a blank IMC101T: 

 Programming of the motion control engine (MCE) 

 Programming of parameter sets for system and motor 

 Programming of customer scripts (optional) 

 Programming of the combined file for an integrated system (optional)  

The iMOTION™ software tools, MCEDesigner and MCEWizard, are required to initially set up the system, as well 

as to control and fine-tune the system performance to match the user’s exact needs. These tools are available 

for download via the Infineon website (Link). Please visit this page periodically to check for tool/software 

updates. 

iMOTION™ Link or on board USB-to-UART cable is needed to bridge the PC/debugger side and motor drive system 

(the target iMOTION™ device, hot side) with 1 kV DC galvanic isolation.   

This chapter provides more details on setting up the system and getting started with the iMOTION™ development 

platform. 

After downloading and installing the iMOTION™ PC tools, MCEWizard and MCEDesigner, the following steps need 

to be taken to run the motor. Refer to MCEWizard and MCEDesigner documentation for more information. 
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Figure 3 shows the basic system connection using EVAL-M1-IM241 to run a 400 W GK6040-6AC31-WEZ1 motor 

with MCEDesigner. 

Figure 3 System connection example  

Figure 4 MCEWizard welcome page  

AC input 

Control board
UVW phase 

output

EMI test ground
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Figure 5 MCEDesigner user interface 

Here are the steps needed to run the motor: 

1. Connect EVAL-M1-101T control board to EVAL-M1-IM241, and connect PC-USB connector to EVAL-M1-101T. 

2. Connect 220 V AC power supply and UVW outputs to the motor. 

3. Use MCEWizard to enter the target motor’s system and operating parameters, as well as evaluation board’s 

hardware parameters, which will then be used to calculate the digital parameter set of the controller 

representing the complete motor drive system.  

4. After system and operating parameters are set, go to the “Verify & Save Page” and click on “Calculate 

Parameters” button. If no errors are reported, then save the drive parameter set into your project directory 

by clicking “Export to MCEDesigner file (.txt)” (Figure 6); if an error is detected, double-click on the error 

message (highlighted in RED) and adjust the related parameter. The saved drive system parameter file will be 

later used by the MCEDesigner in step 9.  

Note: (Please refer to MCEWizard_V2.3.0.0 User Guide.pdf for more details, which is in MCE Wizard’s 

install path)   
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Figure 6 MCEWizard Verify and Save page 

5. Turn on 220 V AC power supply, red LED1 & LED2 ON. 

6. Start MCEDesigner tool and open MCEDesigner default configuration file (.irc) for IMC101T device 

(IMC101T_Vxxx.irc) by clicking “File” > “Open”.   

(IMC101T_Vxxx.irc file is included in downloaded “IMC101T MCE Software Package”) 

7. MCEDesigner should automatically connect to the EVAL-M1-101T board using default COM port (Indicated by 

green circle next to “COMx Up” status in the bottom frame of the MCEDesigner GUI). If it cannot establish the 

connection due to incorrect COM port, change COM port by doing the following steps: click on the “System 

Page” window and then click on “Preferences > Connection > Connect using”, and choose one of the other 

available COM ports from the drop-down list. 

8. In case of blank IC:  If the firmware has been erased from the IMC101T, a warning message will pop up (Figure 

7) saying “Target device firmware and parameters files are not programmed! Please program firmware and 

parameters file.” See step 9 on how to obtain/program firmware and parameters.  

Figure 7 MCEDesigner warning message 

9. In case of blank IC:  Take the following steps to program the firmware and the parameters file into the 

internal Flash memory of iMOTION™ Control IC: Click on system page, click “Tools” > “Programmer” and 

select “Program Firmware and Parameters,” shown as Figure 8 below.  The encrypted firmware is available 

in “IMC101T MCE Software Package,” regarding the parameters file, browse and select the .txt file in step 3. 
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(If blank IMC101T IC, MCE Designer will pop up information “Target device firmware and parameter files are not 

programmed!”)  Program the MCE firmware and system parameters into the internal Flash memory of 

iMOTION™ IC by clicking “Tools > Programmer “in the pull-down menu, and then clicking on the “Program 

Firmware and Parameter” check box. Select right parameter file and firmware file. Finally click “Start” button to 

program firmware and parameter.  Then click YES and then the OK button to update IRC file with parameter 

file; finally “Save As” the IRC file to your own file name that contains COM config, Parameters & firmware file 

path information.   

Note: Please refer to MCEDesigner User Guide.pdf and MCEDesigner_V2.3.0.0 Application Guide.pdf for 

more details, which is in MCE Designer’s install path 

Red LED1 on EVAL-M1-101T will flash on after the program is done. 

Figure 8 MCEDesigner program page 

10. Double click “VF Diagnostic” function in motor1 page, monitor motor current with oscilloscope. If motor 

current is not sinusoidal, change target speed and Vd_Ext in VF Diagnostic sub-function, then double-click 

“VF Diagnostic” until oscilloscope shows a steady sinusoidal current, with amplitude of 30~50% motor rate 

current. 

Double-click “Iu & Iv_Slow” in System page > Monitor Definitions, the motor current feedback would be very 

clean and sinusoidal, as shown in Figure 9, otherwise please tune “Gating Propagation Delay & Phase Shift 

Window Size” in MCE Wizard. The sampled motor current noise amplitude should be less than 50  ~100 

counts (below 5% of motor current, or below 5% of max AD range 2048 counts); otherwise, motor current 

sample related hardware and setup need tuning. 

“VF Diagnostic” sub function can verify: 

 If motor is correctly connected  

 If IGBT / MOS & gate driver work as expected 

 If current sensing related parameters are correctly configured 

 If  PCB layout and DC bus decouple have been done correctly 

After “VF Diagnostic” is done, click STOP button (the red traffic light button) to stop PWM.
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Figure 9 Trace waveform for Iu & Iv open loop diagnostic 

11.  Start the motor by clicking the green traffic light button in the control bar (or double-click Start Motor sub 

function in Motor1 page, group of User Application Function Definitions); motor runs if above step goes well. 

12. Check motor spin direction, adjust UVW connection order or set negative target speed in MCE Designer if 

direction is wrong. 

13. Set target speed to about 50% of MAX speed, start “Iu & Flx_M” trace with “Auto Repeat On Level,” see 

Figure 10. Flx_M is better within the range of 2000~2500 (rated value is 2048), and must be steady and DC-

like.  

Some key tips for better motor-performance tuning: 

 If Flx_M is not steady (swinging or oscillating), double-check motor parameters, speed loop PI gain, flux 

Estimator time constant and PLL PI bandwidth (parameters PLLKp & PLLKi) related setup. 

 If Flx_M is very noisy, double-check current feedback and Vdc-related hardware and parameters. 

 If Flx_M is far from 2048, “Motor Back EMF Constant (Ke)” needs to be adjusted in MCE Wizard. 
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Figure 10 Trace waveform for Iu & Flx-M at 50% speed 

14. Once the firmware has been programmed, in case a new parameter file has to be programmed, follow the 

same instructions given in step 9. In this case, firmware programming is no longer needed and it is possible 

to select the first option “Program Parameters.” 

Note: For detailed information on controller programming, refer to AN2018-33 iMOTION™ 2.0 Device 

Programming, MCEDesigner documentation and MCEWizard documentation. 

2.2 Description of the functional blocks 

The motor inverter of EVAL-M1-IM241 reference design is implemented by the IM241 module, and the auxiliary 

power supply is based on fixed frequency CoolSETTM ICE5GR4780AG. 

2.2.1 Overview of IM241-L6T2B 

Figure 11 illustrates the internal block diagram of the CIPOS™ Micro IPM IM241-L6T2B.  

Main features include: 

 600 V 3-phase inverter including gate drivers & bootstrap function 

 Reverse Conducting IGBT Gen 2 (RCD2) optimized for motor drives 

 Temperature monitor 

 Accurate overcurrent shutdown (±5%) 

 Fault reporting and programmable fault clear 

 Advanced input filter with shoot-through protection 
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 Optimized dV/dt for loss and EMI tradeoffs 

 Open-source for single and leg-shunt current sensing 

 3.3 V logic compatible 

 Isolation 2000 VRMS, 1min  

Figure 11 IM241 internal block 

2.2.2 Overview of ICE5GR4780AG   

The ICE5GR4780AG is Infineon’s latest 5th generation fixed frequency CoolSETTM offers high performance and 

integration of latest generation of 800 V CoolMOSTM P7 super-junction MOSFETs in DSO-12 package.  

Figure 12 illustrates the internal block diagram and typical isolated flyback application. 

Figure 12 ICE5GR4780AG  internal block and typical application in isolated flyback mode 
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Main features of ICE5GR4780AG include: 

 Integrated 700 V/ 800 V avalanche rugged CoolMOSTM

 Enhanced Active Burst Mode with selectable entry and exit standby power 

 Digital frequency reduction for better overall system efficiency 

 Fast startup achieved with cascode configuration 

 DCM and CCM operation with slope compensation 

 Frequency jitter and soft gate driving for low EMI 

 Built-in digital soft start 

 Integrated error amplifier to support direct feedback in non-isolated flyback 

 Comprehensive protection with input line over voltage protection, VCC over voltage, VCC under voltage, 

overload/open loop, over temperature 

 All protections are in auto restart mode 

 Limited charging current for VCC short to GND 

2.2.3 Motor external current feedback configuration and calculation 

The current input value is product of the shunt resistance in milliohms and gain of external current sense 

amplifier for EVAL-M1-101T as shown in Figure 13.  

Figure 13 Current shunt feedback and sample timing for EVAL-M1-101T 

The external amplifier gain circuit can be found in the schematics or user manual for the control board (For 

example, EVAL-M1-101T see Figure 14). 

Figure 14 depicts IU+ current feedback sensing circuity on EVAL-M1-101T evaluation board. Please note that the 

default external amplification gain is less than 1 for current sense in this evaluation board. 

Figure 14 The part of Current feedback on the EVAL-M1-101T evaluation board 
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Based on the principle of Kirchhoff's voltage law, 

𝑉2 ≈ 𝑉1 ≈ (𝑉𝐷𝐷 − 𝐼𝑠ℎ ∗ 𝑅𝑠ℎ) ∗
𝑅7

𝑅6 + 𝑅7
+ 𝐼𝑠ℎ ∗ 𝑅𝑠ℎ =

𝑅7

𝑅6 + 𝑅7
𝑉𝐷𝐷 +

𝑅6

𝑅6 + 𝑅7
𝑅𝑠ℎ ∗ 𝐼𝑠ℎ

𝑐𝑢𝑟𝑟𝑒𝑛𝑡 𝑖𝑛𝑝𝑢𝑡 =
𝑅6

𝑅6 + 𝑅7
𝑅𝑠ℎ =

5

6
𝑅𝑠ℎ

Based on this calculation, the current input for the MADK combination of EVAL-M1-101T and EVAL-M1-IM241 is 

83.3 mV/A. 
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3 System design 

The EVAL-M1-IM241 board is an optimized design for 220 V small home appliances like fan applications. To 

meet individual customer requirements and to make the EVAL-M1-IM241 reference design a basis for 

development or modification, all board design data such as schematics, Gerber and AD files can be found on 

the Infineon homepage. 

3.1 Schematics 

3.1.1 Auxiliary power supply 

Figure 15 depicts the schematic of the auxiliary power supply for the EVAL-M1-IM241 board. The circuit includes 

the latest CoolSETTM 5(ICE5AR4780AG) of Infineon and flyback topology, directly output 15 V and 6 V. VCC is 

connected to the gate drivers inside the CIPOS™ IPM.  

Figure 15 Auxiliary power supply of EVAL-M1-IM241 

The linear voltage regulator IFX25001ME V33 generates 3.3 V from 6 V power supply VCC. The 3.3 V power supply 

is used in the inverter external overcurrent comparator circuit. Both VCC and 3.3 V are also present on the 20-

pins iMOTION™ MADK-M1 interface connector X3 to power circuitry on the control board. 

3.1.2 Inverter section using CIPOS™ Micro  

The inverter section is implemented using the CIPOS™ Micro IPM as sketched in Figure 16. The module includes 

a combination of reverse conducting IGBT Gen 2 (RCD2) optimized and the industry benchmark rugged half-

bridge drivers. The shunt resistor section is also given, including the 0  resistors R23, R24, R25, R26 and R27. 

These resistors allow leg shunt or single shunt via different combinations. The three capacitors C24, C26 and 

C33 are used as bootstrap capacitors to provide the necessary floating supply voltages VBS1, VBS2 and VBS3 

respectively.  
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Figure 16 Schematics  for  IM241 IPM and peripheral circuit 
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3.2 Layout 

This board has two electrical layers with 140 µm copper (2 oz. copper) and dimensions of 100 mm × 100 mm.  

The thickness of the PCB board is 1.6 mm. Figure 17  illustrates the top assembly print of the reference design. 

Figure 17 Top assembly print of the EVAL-M1-IM241 
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Figure 18 depicts the bottom assembly print of the evaluation board. 

Figure 18 Bottom assembly print of the EVAL-M1-IM241 
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The top layer of the PCB is provided in Figure 19. 

Figure 19 Top layer of the EVAL-M1-IM241 
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Figure 20 illustrates the bottom layer routing of the PCB. 

Figure 20 Bottom layer of the EVAL-M1-IM241 

3.3 Bill of material  

The complete bill of material is available on the download section of the Infineon homepage. A log-in is 

required to download this material. 

Table 3 BOM of the most important/critical parts of the evaluation 

S. No. Ref Designator Description Manufacturer Manufacturer P/N 

1 U1 
IC REG LIN 3.3 V 

400 mA SOT223-4 

Infineon 

Technologies 
IFX25001MEV33 

2 U2 
AC-DC Power 

Conversion 

Infineon 

Technologies 
ICE5GR4780AGXUMA1

3 U5 
CIPOS™ Micro IPM 

IM241-L6T2B 

Infineon 

Technologies 
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S. No. Ref Designator Description Manufacturer Manufacturer P/N 

4 CX1, CX2 

CAP FILM 470 nF 630 V 

10% MKP (Metallized 

Polypropylene) 

Wurth Elektronik 890324025039CS 

5 CY3, CY4 

CAP CSSA Multilayer 

Ceramic Chip Safety 

Capacitor X1/Y2 470 

pF 250 VAC 

Wurth Elektronik 8853522110011 

6 C1, C13 

CAP ELCO 150 uF 400 

V 20% 

Aluminiumelectrolytic

Wurth Elektronik 860021381022 

7 L2 Common choke 
Yunlu Energy 

Technology 
0324510376A 

3.4 Connector details 

General information about the connectors of the EVAL-M1-IM241 reference design is provided in this section.  

Table 4 includes the details of the AC input connector. 

Table 4 AC input connector (X1) 

Pin Label Function 

1 E Earth ground 

2 N AC neutral input 

3 L AC line input 

Table 5 provides the details of the motor UVW output connector X2. 

Table 5 Motor side connector (X2) 

Pin Label Function 

1 U Connected to motor phase U 

2 V Connected to motor phase V 

3 W Connected to motor phase W 

Table 6 provides the pin assignments of the 20-pin iMOTION™MADK-M1 interface connector X3. This connector 

is the interface to the controller board. 

Table 6 X3 - iMOTION™MADK-M1 20-pin interface connector for controller board 

Pin Name Pin name connectors 

1 PWMUH 3.3 V compatible logic input for high side gate driver-Phase U 

2 GND Ground 

3 PWMUL 3.3 V compatible logic input for low side gate driver-Phase U 

4 GND GND ground 

5 PWMVH 3.3 V compatible logic input for high side gate driver-Phase V 

6 +3.3 V On board 3.3 V supply 

7 PWMVL 3.3 V compatible logic input for low side gate driver-Phase V 
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Pin Name Pin name connectors 

8 +3.3 V On board 3.3 V supply 

9 PWMWH 3.3 V compatible logic input for high side gate driver-Phase W 

10 I_U Positive current sense output 

11 PWMWL 3.3 V compatible logic input for low side gate driver-Phase W 

12 I_U- Negative current sense output or ground 

13 GK Gatekill signal – active low when overcurrent is detected 

14 DCBSense DC bus positive voltage, scaled in 0-3.3 V range by a voltage divider 

15 VTH Thermistor output 

16 I_V Not used 

17 I_V- Not used 

18 I_W Not used 

19 I_W- Not used 

20 VCC 15 V power supply 

3.5 Test points 

Table 7 provides the assignments of the on-board test points.  

Table 7 The test point for signal measurement 

Pin Name Functions & net label describe 

X4 PWMUH 3.3 V compatible logic input for high side gate driver-Phase U 

X5 PWMUL 3.3 V compatible logic input for low side gate driver-Phase U 

X6 PWMVH 3.3 V compatible logic input for high side gate driver-Phase V 

X7 PWMVL 3.3 V compatible logic input for low side gate driver-Phase V 

X8 PWMWH 3.3 V compatible logic input for high side gate driver-Phase W 

X9 PWMWL 3.3 V compatible logic input for low side gate driver-Phase W 

X10 U Inverter output, motor phase U 

X11 V Inverter output, motor phase V 

X12 W Inverter output, motor phase W 

X13 DCP DCP bus voltage test point 

X14 GND GND test point 

X15 15 V 15 V supply 

X16 3.3 V 3.3 V supply 

X17 SGND SGND test point 

X18 VTH Test point for temperature sensing 
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4 System performance

4.1 Heatsink thermal resistance test result

In order to test the thermal impedance of heatsink to ambient RthCA, the DC source is used to conduct the IPM 

internal diodes, as shown in Figure 21. With the DC source voltage increasing, current through IPM IIPM and 

voltage on IPM VIPM are monitored by current and voltage meter, the IPM case-temperature test point is 

between IPM and heatsink, the same as TC point of inverter IGBT of the IPM datasheet.  

Heatsink

PCB

CIPOS™ Micro IPM IM241

Tc test point

Figure 21 Heatsink thermal testing set-up 

Thermal resistance between junction and ambient RthJA is divided into 2 parts as in the following formula: 

thermal resistance between junction to case RthJC and thermal resistance between case to ambient RthCA. 

𝑅𝑡ℎ𝐽𝐴 = 𝑅𝑡ℎ𝐽𝐶 + 𝑅𝑡ℎ𝐶𝐴

Thus, we get the following formula:  

𝑅𝑡ℎ𝐶𝐴 =
∆𝑇𝐶𝐴

𝑃𝐷.𝑡𝑜𝑡
=

𝑇𝐶 − 𝑇𝐴

𝑉𝐼𝑃𝑀  × 𝐼𝐼𝑃𝑀

The final case-to-ambient resistance value is roughly: 

𝑅𝑡ℎ𝐶𝐴 = 7 ℃/𝑊

4.2 Test results for output ability

In order to test the total output power capability of EVAL-M1-IM241 design, the IPM case temperature is tested 

with different MADK input power and motor output current.  

The test conditions are:  

 Ambient temperature Ta=25℃

 Passive heatsink without fan 

 AC input is VAC=220 V/50 Hz 

 PWM frequency 6 kHz 

 GK6040 motor 
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The module case temperature vs output power is shown as Figure 22. RthCA is based on the existing heatsink on 

the evaluation board and without fan cooling. 

Figure 22 The module case temperature vs output power 
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4.3 Test results for PWM range 

Figure 23 shows the output ability at different PWM frequencies, which are performed under the following 

conditions:  

 6~20 kHz PWM, three-phase modulation  

 The case temperature of IM241-L6T2B reaches 100℃

 Ambient temperature Ta=25℃

 Passive heatsink without fan 

 AC input voltage is VAC=220 V/50 Hz (VDC bus is 300 V~310 V) 

 GK6040 motor 

Figure 23 Output ability at different PWM frequency 
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4.4 Overcurrent protection 

Figure 24 displays the overcurrent protection circuitry. The current sensing signal I_Shunt is connected to 

gatekill (GK) via the comparator U6A. If the motor peak current is larger than the setting value IOCP for more than 

IOCP input filter time, the RFE will be triggered low, which means that the GK signal is active. 

Figure 24 IPM overcurrent protection and over-temperature protection circuit 

The inverter output peak current is about 4 Apeak. 

𝐼𝑂𝐶𝑃 =
[𝑉𝐷𝐷 ∗

𝑅35
𝑅30 + 𝑅35

+ 𝑉𝑜𝑓𝑓𝑠𝑒𝑡] ∗
𝑅36 + 𝑅31

𝑅36 + 𝑉𝐷7

𝑅𝑆𝐻𝑈𝑁𝑇

For iMOTION™ IMC1xx control IC, there are three types of Gatekill input sources (as shown in Figure 25). For the 

input source configured as “Gatekill-Pin” or “Both”, the iMOTION™ control IC will stop the motor when the 

GateKill signal is active. 

But please note that if the comparator for the Gatekill input source is selected, the external Gatekill signal will 

not be used.  And the current-sensing signal I_Shunt will be compared by the internal comparator with the 

“Gatekill Comparator Reference” value only set in MCEWizard. 

Figure 25 Gatekill configuration in MCEWizard for EVAL-M1-101T 
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The signal response of this overcurrent protection circuit is shown in Figure 26. 

Figure 26 Overcurrent protection response waveform 

4.5 Short circuit protection 

Figure 27 displays the short circuit protection circuitry. The module’s ITRIP pin is used as a short circuit 

protection function, and the filtering time is designed to be 2.2 us. The response time waveform of ITRIP is 

shown in Figure 28, which is taken from the datasheet of IM241. 

Figure 27 Short circuit protection 
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Figure 28 ITRIP time waveform 

Please refer to Figure 29,Figure 30 and Figure 31 for actual test waveforms. 

The test results are as follows: 

 TFLT=850 ns 

 TITRIP=1.44 µs 

 TFLT-CLR=62.6 µs 

Figure 29 TFLT waveform 
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Figure 30 TITRIP waveform 

Figure 31 TFLT-CLR waveform 

CH1: Short circuit current (20 mV/A)

CH2: ITRIP 

CH3: U phase 
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CH1: Short circuit current (20 mV/A)

CH2: ITRIP 
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4.6 EMI test results 

Figure 32, Figure 33 and Figure 34 shows the EMI performance at different load, which are performed under the 

following conditions:  

 10 kHz PWM, three-phase modulation  

 GK6040 motor 

 The three types of load are 0.28 A (20%), 0.7 A (50%), 1.4 A (100%) 

 Pass EN55032 standard and more than 3 dB margin 

Figure 32 EMI test waveform at 20% load 

Figure 33 EMI test waveform at 50% load 

EN 55032

L1

Test Equipment - 

               Model - 

             Opertor - 

         Calibrator - 

150.0K 1.0M 10.0M 30.0M

Frequency MHz

-20.0

-6.0

8.0

22.0

36.0

50.0

64.0

78.0

92.0

106.0

120.0

A
m

p
li

tu
d

e
 d

B
u

V

CISPR_QP

CISPR_AV

Line PK

Line AV

Mark

QP

Ave

AV_Mark

150.0 KHz
49.758

474.0 KHz
52.346

534.0 KHz
49.703

17.54 MHz
55.399

438.0 KHz
43.139

500.0 KHz
43.141

5.0 MHz
43.287

5.001 MHz
43.287

21.422 MHz
43.823

EN 55032

L1

Test Equipment - 

               Model - 

             Opertor - 

         Calibrator - 

150.0K 1.0M 10.0M 30.0M

Frequency MHz

-20.0

-6.0

8.0

22.0

36.0

50.0

64.0

78.0

92.0

106.0

120.0

A
m

p
li

tu
d

e
 d

B
u

V

CISPR_QP

CISPR_AV

Line PK

Line AV

Mark

QP

Ave

AV_Mark

162.0 KHz
51.929

442.0 KHz
52.721

18.708 MHz
55.991

434.0 KHz
43.313

500.0 KHz
43.315

5.0 MHz
43.445

5.001 MHz
43.445

18.228 MHz
43.825

20% load

50% load



User guide 35 of 38 V0.1  

2021-03-19 

EVAL-M1-IM241 user guide 
iMOTION™ modular application design kit

System performance 

Figure 34 EMI test waveform at 100% load 
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5 References and appendices 

5.1 Abbreviations and definitions 

Table 8 Abbreviations 

Abbreviation Meaning 

CE Conformité Européenne 

EMI Electromagnetic interference 

UL Underwriters Laboratories 

GK Gate kill 

5.2 References 

[1] Infineon Technologies AG. Datasheet of Infineon IM241-L6T2B (2021). V1.0  www.infineon.com

[2] Infineon Technologies AG. Datasheet of Infineon IMC101T-T038 (2019). V1.4  www.infineon.com

[3] Infineon Technologies AG. MCEWizard_V2.3.0.0 User Guide (2019) www.infineon.com

[4] Infineon Technologies AG. MCEDesigner_V2.3.0.0 Application Guide (2019) www.infineon.com

[5] Infineon Technologies AG. iMOTION™ Motion Control Engine Software Reference Manual (2020) V1.3  

www.infineon.com

5.3 Ordering details and other information  

The power board is now available for customers in small order quantities. In order to initiate the testing, 

customers are advised to order the following items: 

Base Part Number Package Standard Pack Orderable Part Number 

Form Quantity

EVAL-M1-IM241 EVAL Boxed 1 EVALM1IM241TOBO1

ICE54780AG PG-DSO-12 TAPE&REEL 2500 ICE5GR4780AGXUMA1

IM241-L6T2B DIP 29x12 
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